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AC6563 Paper space and plotting using AutoCAD software applications can be overwhelming and
frustrating. Paper space is often misunderstood and plotting is not necessarily the most intuitive task.
This class will work through the process of setting up a drawing for plotter output using paper space
layouts. You will learn about viewport scaling and viewport property overrides, as well as how to
effectively use Page Setups to easily change plot settings.

Learning Objectives
At the end of this class, you will be able to:

e Learn how to set up a layout with multiple viewports
e Learn how to modify scale factors and properties of individual viewports
e Learn how to add a page setup and plot output device

e Troubleshoot tips and tricks

About the Speaker
Employed at Autodesk, Inc., as a product support specialist, Volker Cocco has been working
with AutoCAD software since 1991 (that's R10 in CAD speak). He has been working for various
Autodesk Resellers since 1997, and he has had extensive experience troubleshooting and
supporting Autodesk products. In addition to having a background in CAD drafting and
management, Volker has instructed basic to advanced AutoCAD technical classes, including
sessions at AUGI CAD Camp and Autodesk University.
volker.cocco@autodesk.com
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Plotting Overview
What is the Difference between Printing and Plotting?

The terms printing and plotting can be used interchangeably for CAD output. Historically, printers would
generate text only, and plotters would generate vector graphics. As printers became more powerful and
could generate high-quality raster images of vector data, the distinction largely disappeared and the
terms are now interchangeable.

Key Features for Plotting in AutoCAD

Unlike other Windows applications, the process of printing in AutoCAD may at first appear a bit daunting
as well as confusing. The bottom line is that it is all a matter of understanding the settings, applying the
settings and then saving the settings for reuse or modification. One should become familiar with the
following:

Plotter Manager

The Plotter Manager is a window that lists plotter configuration (PC3) files for every non-system printer
that you install. Plotter configuration files can also be created for Windows ® system printers if you want
to use default properties different from those used by Windows. Plotter configuration settings specify
port information, raster and vector graphics quality, paper sizes, and custom properties that depend on
the plotter type.

The Plotter Manager contains the Add-a-Plotter wizard, which is the primary tool for creating plotter
configurations. The Add-a-Plotter wizard prompts you for information about the plotter that you want
to set up.

Layouts
A layout represents a drawing sheet, and typically includes

e Adrawing border and title block
e One or more layout viewports that display views of model space
e General notes, labels, and possibly dimensions
e Tables and schedules
Usually a drawing file contains only one layout, but you can create as many layouts as you need. The

first time you display a layout, it is initialized and a default page setup is assigned to it.

Once initialized, layouts can be modified, published, and added to sheet sets as sheets.
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Page Setups

When you create a layout, you specify a plotter, and settings such as paper size and orientation. These
settings are saved in the drawing as a page setup. Each layout can be associated with a different page
setup.

You can control these settings for layouts and for model space using the Page Setup Manager. You can
name and save page setups for use with other layouts.

If you do not specify all the settings in the Page Setup dialog box when you create a layout, you can set
up the page just before you plot. Or you can override a page setup at plot time. You can use the new
page setup temporarily for the current plot, or you can save the new page setup.

Plot Styles

e Aplot style is an optional method that controls how each object or layer is plotted.
Assigning a plot style to an object or a layer overrides properties such as color,
lineweight, and linetype when plotting. Only the appearance of plotted objects is
affected by plot style.

e Plot style tables collect groups of plot styles, and save them in a file that you can later
apply when plotting.

e The Plot Style Manager is a folder that contains all the available plot style tables, along
with the Add-A-Plot-Style wizard.

e There are two plot style types: color-dependent and named. A drawing can use only one
type of plot style table. You can convert a plot style table from one type to the other.
You can also change the type of plot style table a drawing uses once it has been set.

e For color-dependent plot style tables, an object's color determines how it is plotted.
These plot style table files have .ctb extensions. You cannot assign color-dependent plot
styles directly to objects. Instead, to control how an object is plotted, you change its
color. For example, all objects assigned the color red in a drawing are plotted the same
way.

e Named plot style tables use plot styles that are assigned directly to objects and layers.
These plot style table files have .stb extensions. Using them enables each object in a
drawing to be plotted differently, independent of its color.
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The reality is that you don’t need to use all of these features. In fact, you could easily select the print
function and create a hard copy. What these tools allow you to do is to take the guesswork out of

plotting drawings by providing an accurate paper-based visual representation of a drawing before it is
plotted.
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Preparing to Plot
The first item we need to explore is the output device, your physical printer or a software device such as
a PDF driver; after all, we need something to plot to, right?

One can easily plot to any output device for which a driver is installed on the system; however, adding
and working with a Plotter Configuration (PC3) file gives the user additional flexibility over the output.
PC3 files are configured and modified using the Plotter Manager.

About the Plotter Manager:

Use the Plotter Manager to create and manage plotter configurations. From the Plotter Manager, you
choose the Add-A-Plotter wizard to step through the process of configuring a plot device, and then
create a plotter configuration (PC3) file that stores the plotter settings. One then uses the plotter
configuration file to set up the plotter at plot time. The Plotter Configuration editor modifies existing
plotter configuration files. From the Plotter Manager, double-click an existing PC3 file to display the
Plotter Configuration Editor Dialog box.

The Plotter Manager is basically a shortcut which displays the location where the Add-A-Plotter wizard
and the Plotter Configuration Editor are accessed, as well as any PC3 files.

Do one of the following:

e Click Application menu » Print » Manage Plotters.
e Click Application menu » Options. On the Plot and Publish tab, click Add or Configure Plotters.
e Command Line » PLOTTERMANAGER
e Windows Control Panel » Autodesk Plotter Manager
Once invoked a Windows Explorer dialog appears pointing to a folder which by default is,

“C:\Users\<user name>\AppData\Roaming\Autodesk\AutoCAD 2015\R20.0\enu\Plotters”. This path is
stored in the Windows Registry and may be modified through the AutoCAD Options dialog » Files tab
» Support Files Search Path.

About Setting up Plotters and Printers
Each plotter configuration contains information such as the device driver and model, the output port to
which the device is connected, and various device-specific settings.

The program lists the available configured system and HDI non-system printers or plotters. You do not
need to configure system devices unless the program defaults differ from those of the operating system.
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If a plotter is supported by the program, but not by the operating system, you can use one of the HDI
non-system printer or plotter drivers. You can also use a non-system driver to create PostScript, raster
image, Design Web format (DWF), or Portable Document Format (PDF) files.

The program stores information about the media and plotting device in configured plot (PC3) files. Plot
configurations are portable and can be shared in an office or on a project as long as they are for the
same driver and model. Plot configurations for system printers may also be shared, but need to be
shared on the same version of an operating system. If you calibrate a plotter, the calibration information
is stored in a plot model parameter (PMP) file that you can attach to any PC3 files you create for the
calibrated plotter.

Note: If you upgrade a driver, try using your existing PC3 file. If it does not work, then you will need to
create a new PC3 file.

PC3 files are added by using the Add-A-Plotter wizard, although fairly straight forward there may be
some confusion as to which options to choose. The biggest hurdle is understanding which option to
choose for a driver. Three choices are given in The Add-A-Plotter wizard, Add Plotter-Begin Page:

e My Computer. The program uses an HDI (Heidi® Device Interface) driver to translate drawing
geometry to a plot device directly connected to your computer. An HDI driver is an internal or
non-system driver specifically developed to handle the unique hardcopy requirements of the
program when translating drawing geometry to a variety of defined devices. If you select this
option, the plot output will be limited to sending through the communication ports of the local
system, to a file, or to AutoSpool.

e Network Plotter Server. The program uses an HDI driver, just as above; however, the
configuration requires you to select a plot device shared from another computer on the
network.

e System Printer. The program uses a System Printer driver installed on your computer. Select this
option when you already have a Windows system printer driver installed. It is possible to print
from the program using a System printer without first configuring with this option. However, if
you select this option, the settings made to the device driver for the program will not affect your
other Windows applications.
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Plotter Configuration Parameter versions

J PCP file introduced in AutoCAD R12
. PC2 file introduced in AutoCAD R14
. PC3 file introduced in AutoCAD 2000

The following is an example for adding a DWG to PDF.PC3 driver. This driver is installed with AutoCAD as
a default so you don’t necessarily need to install it unless the original becomes corrupt; having said that,
it does provide a good example as to how to use the Add-A-Plotter Wizard.

1. Inthe Windows Control Panel select "Autodesk Plotter Manager"
(Optional, but recommended) Select the existing "DWG to PDF.PC3" file and rename it.

Double-Click the Add-A-Plotter Wizard

In the "Add Plotter - Introduction" dialog, Click Next

In the "Add Plotter - Begin" dialog, Select "My Computer", Click Next

In the "Add Plotter - Plotter Model" dialog, Select "Autodesk ePlot (PDF), Click Next
In the "Add Plotter - Import Pcp or PC2" dialog, Click Next

In the "Add Plotter - Ports" dialog, Select "Plot to Flle", Click Next

In the "Add Plotter - Plotter Name" dialog, Click Next

In the "Add Plotter - Finish" dialog, Click Finish

LNV A WN

Once a PC3 has been added it can be modified using the Plotter Configuration Editor. The Finish page of
the Add-A-Plotter wizard also gave you this option.

There are numerous options available for modifying the PC3. One of the most common tweaks is to add
a custom paper size.

When one modifies a PC3 file for a nonsystem printer a Plot Model Parameter file (PMP) is created. The
PMP file contains custom plotter calibration and custom paper size information associated with the PC3
file. Creating custom page sizes for a PC3 file will automatically create a PMP file. This file is then
referenced by the PC3.
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Typically PMP files are stored in “C:\Users\<user name>\AppData\Roaming\Autodesk\AutoCAD
2015\R20.0\enu\Plotters\PMP Files”. This path is stored in the Windows Registry and may be modified
through the AutoCAD Options dialog » Files tab » Support Files Search Path.

The following is an example for modifying custom papers sizes using the Plotter Configuration Editor:

1. Type PLOTTERMANAGER at the command line.

2. Inthe Plotter Manager, double-click the PC3 file whose configuration you want to
change.

3. Inthe Plotter Configuration Editor, Device and Document Settings tab, under the User
Defined Paper Sizes & calibration, select Custom Paper Sizes.

4. Set a new paper size using one of the following methods:

a. To add a custom paper size, click Add and follow the steps in the Custom Paper
Size wizard. You specify the size of the paper, the printable area, and a name for
the new paper size.

b. To edit an existing paper size, under Custom Paper Sizes, select the paper size
and click Edit. The Custom Paper Size wizard opens. Change any of the paper size
settings.

5. Click OK.

Note that creating a custom paper size for a nonsystem driver attaches a plot model parameter (PMP)
file to the plotter configuration (PC3) file. The PMP file contains custom plotter calibration and custom
paper size information. By default, PMP files are stored in the PMP Files folder.

Additionally; for a System printer, you will need to set custom page sizes in the Windows printer section.
If you try and do this through the AutoCAD plot dialog box as you would for a nonsystem plotter, the
options will be grayed out.

I’'ve provided a link to additional documentation for modifying PC3 files (including the use of custom
paper sizes), at the end of this document.
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Plotting Your Drawing
With AutoCAD you plot a drawing from either model space or paper space. Model [WEREET
layouts are used to draw objects in real world units. For example, a wall twelve 17128 = 107 / 0.07%

feet long is drawn at that length. Since a twelve foot object doesn’t fit easily on a A R
132" =1-0° /1 0.26%
17167 = 1-0° f 0.52%
3f32° =1-0" /0.78%
scale factor is used to determine the plot scale, text height, dimension scale and 18" = 107 / 1L.04%

sheet of paper additional scaling must be done in order to plot the objects. One
must determine the drawing scale factor before one starts drawing. The drawing

linetype scale of the drawing. For example, if your drawing has a scale factor of 316" = 10" / L56%
1/4° = 1'-07 f 2.08%
3/8" = 1'-0" F1.13%

12" =1'0" f4.17%
e Plot scale factor of 1/8”=1'0" & :
34" = 1'-0" f 6.25%

e Dimension scale of 96 (1’ / 1/8” = 96) = 10 83%
e Linetype scale of 96 112" = 10"/ 125%
o Text height of 12”7 (96 x 1/8” = 12”) for a plot text height of 1/8”". 3 =107/ 25%

Note that using AutoCAD’s Scale list and Annotation Scaling simplifies this process. 6" =107/ 50%
1'-0° = 1"-0° F 100%

1/8”=1’-0", it may require that some or all of the following settings be applied:

Check out the resource page for additional information.

Custom...

Xref scales

+ Percentages

On the other hand, paper space layouts allow us to plot at a scale factor of 1:1. A layout represents a

drawing sheet, and typically includes:
AutoCAD Scale List

e Adrawing border and title block
e One or more layout viewports that display views of model space at a desired scale factor
e General notes, labels, and possibly dimensions
e Tables and schedules
Usually a drawing file contains only one layout, but you can create as many layouts as you need. There is

a limit of a total of 255 layouts (including model). The first time you display a layout, it is initialized and a
default page setup is assigned to it.

Once initialized, layouts can be modified, published, and added to sheet sets as sheets.

Plotting a Model Layout
Prior to plotting the model layout, let’s take a look at the Plot dialog and its attributes:

The Plot dialog specifies device and media settings, and plots your drawing.
Do one of the following:

e Click Application menu » Print > Plot.



e Ribbon » Outputtab » Plot

e Quick Access Toolbar » Plot

e Command Line » PRINT or PLOT
The Plot dialog will be displayed.
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Flot to file

Paper size

Description:  The layout will not be plotted unless a new plotter
configuration name is selected,

Mumber of copies

.
A Plot - Model [
Page setup Flot style table (pen assignments)
Name: {(Nune> 'I I Add, ] INDI‘IE vI =
Printer fplotter Shaded viewport options
Mame: {@ None 'I ertie: Shade plot As displayed -
Flotter: MNone Quiality Mormal >
Where: Mot applicable

Plot options
[T Plot in background
Plot object lineweights

[ Plot transparency
IIso A4 (210,00 x 297,00 MM) -] 1 [Z1Flotwith ot syies
Plot area Plot scale Plot paperspace last
What to plot: Fit to paper Hide paperspace objects
Display - [ Plot stamp on
Scale: | Custom
[ 5ave changes to layout
Flot offeet (origin set to printable area) 1 mm x| = Drawing orientation
X 1155 b [CIigenter the plot 0.2369 @) Portrait
13.65 ") Landscape @
o mm Scale lineweights
- HE S [ Plot upside-down
Preview... Apply to Layout J [ Ok ] I Cancel J I Help J @

You can display more options by clicking the More Options button. @

List of Options
The following options are displayed.

Page Setup - Displays a list of any named and saved page setups in the drawing. You can base the
current page setup on a named page setup saved in the drawing, or you can create a new named page
setup based on the current settings in the Plot dialog box by clicking Add.

Name - Displays the name of the current page setup.

Add - Displays the Add Page Setup dialog box, in which you can save the current settings in the Plot
dialog box to a named page setup. You can modify this page setup through the Page Setup Manager.

Printer/Plotter - Specifies a configured plotting device to use when plotting layouts.

If the selected plotter doesn't support the layout's selected paper size, a warning is displayed and you
can select the plotter's default paper size or a custom paper size.

Name - Lists the available PC3 files or system printers from which you can select to plot the current
layout. An icon in front of the device name identifies it as a PC3 file or a system printer.

10
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e PC3fileicon. Indicates a PC3 file.

&

e System printer icon. Indicates a system printer.

&

Properties - Displays the Plotter Configuration Editor (PC3 editor), in which you can view or modify the
current plotter configuration, ports, device, and media settings.

If you make changes to the PC3 file using the Plotter Configuration Editor, the Changes to a Printer
Configuration File dialog box is displayed.

Plotter - Displays the plot device specified in the currently selected page setup.

Where - Displays the physical location of the output device specified in the currently selected page
setup.

Description - Displays descriptive text about the output device specified in the currently selected page
setup. You can edit this text in the Plotter Configuration Editor.

Plot to File - Plots output to a file rather than to a plotter or printer. The default location for plot files is
specified in the Options dialog box, Plot and Publish tab, under Default Location for Plot-to-File
Operations.

If the Plot to File option is turned on, when you click OK in the Plot dialog box, the Plot to File dialog box
(a standard file navigation dialog box) is displayed.

Partial Preview - Shows an accurate representation of the effective plot area relative to the paper size
and printable area. The tooltip displays the paper size and printable area.

F— 82" —3

11.0°

Paper Size - Displays standard paper sizes that are available for the selected plotting device. If no plotter
is selected, the full standard paper size list is displayed and available for selection.

If the selected plotter doesn't support the layout's selected paper size, a warning is displayed, and you
can select the plotter's default paper size or a custom paper size.

A default paper size is set for the plotting device when you create a PC3 file with the Add-a-Plotter
wizard. The paper size that you select in the Page Setup dialog box is saved with the layout and
overrides the PC3 file settings.

11
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The actual printable area of the page, which is determined by the selected plotting device and paper
size, is indicated in the layout by a dashed line.

If you are plotting a raster image, such as a BMP or TIFF file, the size of the plot is specified in pixels, not
in inches or millimeters.

Number of Copies - Specifies the number of copies to plot. This option is not available when you plot to
file.

Plot Area - Specifies the portion of the drawing to be plotted. Under What to Plot, you can select an
area of the drawing to be plotted.

Layout/Limits - When plotting a layout, plots everything within the printable area of the specified paper
size, with the origin calculated from 0,0 in the layout.

When plotting from the Model tab, plots the entire drawing area that is defined by the grid limits. If the
current viewport does not display a plan view, this option has the same effect as the Extents option.

Extents - Plots the portion of the current space of the drawing that contains objects. All geometry in the
current space is plotted. The drawing may be regenerated to recalculate the extents before plotting.

Display - Plots the view in the current viewport in the selected Model tab or the current paper space
view in the layout.

View - Plots a view that was previously saved with the VIEW command. You can select a named view
from the list. If there are no saved views in the drawing, this option is unavailable.

When the View option is selected, a View list is displayed that lists the named views that are saved in
the current drawing. You can select a view from this list to plot.

Window - Plots any portion of the drawing that you specify. When you select Window, the Window
button becomes available. Click the Window button to use the pointing device to specify the two
corners of the area to be plotted, or enter coordinate values.

Plot Offset - Specifies an offset of the plot area relative to the lower-left corner of the printable area or
to the edge of the paper, depending on the setting made in the Specify Plot Offset Relative To option
(Options dialog box, Plot and Publish tab). The Plot Offset area of the Plot dialog box displays the
specified plot offset option in parentheses.

The printable area of a drawing sheet is defined by the selected output device and is represented by a
dashed line in a layout. When you change to another output device, the printable area may change.

You can offset the geometry on the paper by entering a positive or negative value in the X and Y offset
boxes. The plotter unit values are in inches or millimeters on the paper.

12
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Center the Plot - Automatically calculates the X and Y offset values to center the plot on the paper. This
option is not available when Plot Area is set to Layout.

e X - Specifies the plot origin in the X direction relative to the setting of the Plot Offset
Definition option.
e Y -Specifies the plot origin in the Y direction relative to the setting of the Plot Offset
Definition option.
Plot Scale - Controls the relative size of drawing units to plotted units. The default scale setting is 1:1
when plotting a layout. The default setting is Fit to Paper when plotting from the Model tab.

Fit to Paper - Scales the plot to fit within the selected paper size and displays the custom scale factor in
the Scale, Inch =, and Units boxes.

Scale - Defines the exact scale for the plot. Custom defines a user-defined scale. You can create a custom
scale by entering the number of inches (or millimeters) equal to the number of drawing units.

Inch(es) =/mm =/Pixel(s) = - Specifies the number of inches, millimeters, or pixels equal to the specified
number of units.

Inch/mm/pixel - Specifies inches or mm for display of units in the Plot dialog box. The default is based
on the paper size and changes each time a new paper size is selected. Pixel is available only when a
raster output is selected.

Units - Specifies the number of units equal to the specified number of inches, millimeters, or pixels.

Scale Lineweights - Scales lineweights in proportion to the plot scale. Lineweights normally specify the
linewidth of plotted objects and are plotted with the linewidth size regardless of the plot scale.

Note: You can modify the list of scales with SCALELISTEDIT.

Preview - Displays the drawing as it will appear when plotted by starting the PREVIEW command. To exit
the preview and return to the Plot dialog box, press ESC, press ENTER, or right-click and then click Exit
on the shortcut menu.

Apply to Layout - Saves the current Plot dialog box settings to the current layout.

More Options - Controls display of additional options in the Plot dialog box.

®

e Plot Style Table (Pen Assignments)
e Shaded Viewport Options

e Plot Options

e Drawing Orientation

13
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Plot Style Table (Pen Assignments) - Sets the plot style table, edits the plot style table, or creates a new
plot style table.

Name (Unlabeled) - Displays the plot style table that is assigned to the current Model tab or layout tab
and provides a list of the currently available plot style tables.

If you select New, the Add Plot Style Table wizard is displayed, which you can use to create a new plot
style table. The wizard that is displayed is determined by whether the current drawing is in color-
dependent or named mode.

Edit - Displays the Plot Style Table Editor, in which you can view or modify plot styles for the currently
assigned plot style table.

Vs

Shaded Viewport Options - Specifies how shaded and rendered viewports are plotted and determines
their resolution level and dots per inch (dpi). Rendered viewport options are not available in AutoCAD
LT.

Note: When hardware acceleration is disabled or is enabled, but does not support Shadows, it is
possible to plot a drawing that contains shaded viewports with unsupported hardware effects by the
graphics card through software emulation. To enable the software emulation of hardware effects that
are not supported by your graphics card, enter 3DCONFIG and click Manual Tune. In the Manual
Performance Tuning dialog box, click Emulate unsupported hardware effects in software when plotting.
The unsupported effects will not appear in the viewport in real-time, but will appear in the hardcopy or
electronic file that is created during the plot process. (Not applicable to AutoCAD LT)

Shade Plot - Specifies how views are plotted. To specify this setting for a viewport on a layout tab, select
the viewport and then, on the Tools menu, click Properties.

From the Model tab, you can select from the following options:

e As Displayed. Plots objects the way they are displayed on the screen. (Available in AutoCAD LT)

e Legacy Wireframe. Objects in wireframe regardless of the way they are displayed on the screen,
using the legacy SHADEMODE command. (Available in AutoCAD LT)

e Legacy Hidden. Objects with hidden lines removed regardless of the way the objects are
displayed on the screen, using the legacy SHADEMODE command. (Available in AutoCAD LT)

e Conceptual. Plots objects with the Conceptual visual style applied regardless of the way the
objects are displayed on the screen.

e Hidden. Plots objects with hidden lines removed regardless of the way the objects are displayed
on the screen.

e Realistic. Plots objects with the Realistic visual style applied regardless of the way the objects
are displayed on the screen.

14
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Shaded. Plots objects with Shaded visual style applied regardless of the way the objects are
displayed on the screen

Shaded with Edges. Plots objects with Shaded with Edges visual style applied regardless of the
way the objects are displayed on the screen

Shades of Gray. Plots objects with Shades of Gray visual style applied regardless of the way the
objects are displayed on the screen.

Sketchy. Plots objects with Sketchy visual style applied regardless of the way the objects are
displayed on the screen.

Wireframe. Plots objects in wireframe regardless of the way they are displayed on the screen.
X-ray. Plots objects with x-ray visual style applied regardless of the way the objects are
displayed on the screen

Rendered. Plots objects as rendered regardless of the way they are displayed on the screen.

Quality - Specifies the resolution at which shaded and rendered viewports are plotted.

You can select from the following resolution options:

Draft. Sets rendered and shaded model space views to be plotted as wireframe.

Preview. Sets rendered and shaded model space views to be plotted at one quarter of the
current device resolution, to a maximum of 150 dpi.

Normal. Sets rendered and shaded model space views to be plotted at one half of the current
device resolution, to a maximum of 300 dpi.

Presentation. Sets rendered and shaded model space views to be plotted at the current device
resolution, to a maximum of 600 dpi.

Maximum. Sets rendered and shaded model space views to be plotted at the current device
resolution with no maximum.

Custom. Sets rendered and shaded model space views to be plotted at the resolution setting
that you specify in the DPI box, up to the current device resolution.

DPI - Specifies the dots per inch for shaded and rendered views, up to the maximum resolution of the

current plotting device. This option is available if you select Custom in the Quality box.

Plot Options - Specifies options for lineweights, transparency, plot styles, shaded plots, and the order in

which objects are plotted.

Plot in Background - Specifies that the plot is processed in the background. (BACKGROUNDPLOT system
variable)

Plot Object Lineweights - Specifies whether lineweights assigned to objects and layers are plotted.

Plot Transparency - Specifies whether object transparency is plotted. This option should only be used

when plotting drawings with transparent objects.

Attention: For perfomance reasons, plotting transparency is disabled by default. To plot transparent

objects, select the Plot Transparency option. This setting can be overridden by the
PLOTTRANSPARENCYOVERRIDE system variable. By default, the system variable honors the setting in the
Page Setup and the Plot dialog boxes.

15
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Plot with Plot Styles - Specifies whether plot styles applied to objects and layers are plotted.

Plot Paperspace Last - Plots model space geometry first. Paper space geometry is usually plotted before
model space geometry.

Hide Paperspace Objects - Specifies whether the HIDE operation applies to objects in the paper space
viewport. This option is available only from a layout tab. The effect of this setting is reflected in the plot
preview, but not in the layout.

Plot Stamp On - Turns on plot stamping. Places a plot stamp on a specified corner of each drawing
and/or logs it to a file.

Plot stamp settings are specified in the Plot Stamp dialog box, in which you can specify the information

that you want applied to the plot stamp, such as drawing name, date and time, plot scale, and so on. To
open the Plot Stamp dialog box, select the Plot Stamp On option, and then click the Plot Stamp Settings
button that is displayed to the right of the option.

You can also open the Plot Stamp dialog box by clicking the Plot Stamp Settings button on the Plot and
Publish tab of the Options dialog box.

Plot Stamp Settings button - Displays the Plot Stamp dialog box when the Plot Stamp On option is
selected in the Plot dialog box.

Save Changes to Layout - Saves changes that you make in the Plot dialog box to the layout.

Drawing Orientation - Specifies the orientation of the drawing on the paper for plotters that support
landscape or portrait orientation. The paper icon represents the media orientation of the selected
paper. The letter icon represents the orientation of the drawing on the page.

e Portrait - Orients and plots the drawing so that the short edge of the paper represents
the top of the page.
e Landscape - Orients and plots the drawing so that the long edge of the paper represents
the top of the page.
e Plot Upside-Down - Orients and plots the drawing upside down.
Icon - Indicates the media orientation of the selected paper and represents the orientation of the

drawing on the page as a letter on the paper.
Note: Drawing orientation is also affected by the PLOTROTMODE system variable.

Less Options - Hides the following options in the Plot dialog box:

16
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Plot Style Table (Pen Assignments)
Shaded Viewport Options

Plot Options

Drawing Orientation

17
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Exercise: Plotting from model space

Lo N WNRE

[ N
W N R O

Open "Floor Plan Plot.dwg"

Type Plot at the command prompt
Printer/Plotter: Select DWG to PDF.PC3

Paper size: Select ANSI E (34.00 x 44.00 Inches)
Plot area (What to Plot): Limits

Plot scale:

Uncheck "Fit to paper"

Scale: Select 1/8" = 1'0"

Plot Offset: Center the plot

. Select Preview

. Dismiss the Plot - Plot Scale Confirm dialog, selecting Continue
. Zoom and Pan in the Preview Window using the wheel on the mouse
. Right-Mouse click and select Plot

Frinterfphotter

Nome: | FROWG To POFecd

Fotter: DWW To POF - PDF &Flot - by Autodesk
Where: Fie

Description:

Paper size

| A1 (34,00 44,00 Inches)

Settings for the Plot dialog

Plat aeea Pt senle
‘What to plot: Fit to paper

Pt affset (origin set tn prntable anea) 0125 [nches  +|"

¥ | .05 ) Centes the ot ]
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The Plot Preview

FWIW Department:

In the previous example we chose LIMITS for the area to plot. One could have chosen extents which
would have plotted to the edge of the physical entities in the drawing. This works best when a title block
or some type of border is added conforming to the paper sheet size. Try the model plot example by
changing the setting to EXTENTS.

Limits, although still in use, are considered more of a legacy function which set an invisible boundary in
the drawing area. Having said that, one can get a visual on limits set in the drawing using the GRID
command. Although limits can be set both in the model and paper space environment, they are used
primarily in model space. This option is not available in the Plot dialog for paper space layouts, instead
the option Layout is used. I've provided a link for more information on Limits in the resource section of
this document.

As | mentioned, the GRID command will show a visual of the limits set in a drawing. You may have
noticed that the grid, when enabled (default), overlays the entire drawing editor. The following are the
changes | made to the grid and limits in order to provide a visual representation of the sheet size being
used to plot my model layout.

1. If not already turned on, enable the GRID (F7 function key)
2. Type LIMITS at the command prompt
3. ENTER to accept the default 0,0 lower left corner

Notice that the next prompt, "LIMITS Specify upper right corner" is set to a value of 12,9. This is the
default size of an A sized engineering sheet of paper. In this example we are using an ANSI E 34x44, so
we need to resize the limits by scaling the sheet by a factor of 96 (1/8"=1'0).

96 x 34 =3264

96 x44 =4224
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4. For the Landscape orientation enter: 4224,3264.

The command line should show a history as follows (F2 for text window):
Command:
LIMITS
Reset Model space limits:
Specify lower left corner or [ON/OFF] <0.0000,0.0000>:
Specify upper right corner <12.0000,9.0000>: 4224,3264

We've set the size of our sheet of paper, but the Grid is still in full display. You can change this as

follows:

1. Type GRID at the command prompt
2. Select LIMITS or type L at the command prompt.
3. Atthe prompt, "GRID Display grid beyond Limits", Select or enter No
If all works as expected, you will now see a visual representation of the limits for an ANSI E 34x44, sheet

of paper scale to a factor of 96.

The command line history will display:
Command:
GRID
Specify grid spacing(X) or [ON/OFF/Snap/Major/aDaptive/Limits/Follow/Aspect] <0.5000>: L
Display grid beyond Limits [Yes/No] <Yes>: n

In my humble opinion, plotting from a paper space layout is a much easier process and allows for
greater flexibility.
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About Paper Space Layouts

Use paper space layouts to compose or lay out a model space drawing for plotting. A layout can consist
of a title bloc, one or more viewports, details and annotations. Layouts use the drawing plot settings and
plot style tables to create a visual representation of a paper drawing. The paper representation takes
into account the plot device, paper size, paper, orientation, printable area, scale, plotting area,
lineweights, color screening, and other visual properties of objects. These are combined to create a
WYSIWYG (What You See Is What You Get) representation of your drawing when it is plotted. This takes
the guesswork out of plotting. Paper space layouts show you exactly how your drawing will plot prior to
plotting.

When paper space was first introduced in AutoCAD Release 11, there was only one paper space
environment. No layouts. This changed with the release of AutoCAD 2000 and now an AutoCAD drawing
can contain up to 255 layout (including the model layout). Layouts can be renamed, copied, moved, or
deleted as necessary. The one caveat is that the model layout, in addition to one paper layout will
always be in the drawing, in other words, you cannot delete either.

Each layout can contain multiple viewports, although there is a limit of 64 viewports per layout. This is
controlled by the MAXACTVP system variable which is saved in the drawing file.

Note: Previous versions of AutoCAD had limits as low as 16 viewports in paper space. Since the
variable is saved in the drawing file, if you are unable to create less than 64 viewports, change
the settings of the MAXACTVP variable. Additionally, each viewport requires additional
resources from your graphics card. If you have numerous viewports and the model is not being
displayed, try the REGENALL command or select one of the affected viewports. The model
should then display. Bear in mind that even if the model does not appear, once you plot the
drawing a Regeneration of the drawing database will occur and all objects will plot as expected.

To sum this up, a paper space layout represents the paper on which the drawing will be plotted.
AutoCAD layouts give the flexibility to plot the same drawing in different ways. Each layout represents
an individual plot output or an individual sheet in a drawing project where viewports and page settings
for each layout are specified.
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Some Key Terms

Page Setup — This saves the current plot settings with the Model tab and each Layout tab. If you select
“Save Changes to Layout” in the Plot dialog box, the plot settings are saves as a page setup after each
plot. The page setup information that is saved with each layout or model space is used as the default
settings the next time you plot.

Named Page Setup — This names the current plot settings that you save in your drawing. Named page
setups can be applied to other layouts you want to plot that require the same settings. Multiple named
setups can be created in the same drawing for plotting to different scales and sheet sizes, output
devices as well as other plotting preferences. These Named page setups can be imported into other
drawing files as well.

Plot area — Layout — Prints all the geometry within the margins of the paper. Note that this option is only
available in a paper space layout.

Floating Viewport — Displays a rectangular view of the model in paper space.

Nonrectangular Viewport — Displays a non-rectangular view of the model. Can be created using a
polyline, circle, region, spline, or ellipse. It can also be created by converting a closed object, such as a
circle, into a viewport

Viewport Scale — This represents a ratio between the actual size of the model displayed in the viewports
and the sized of layout in paper space. The ratio is determined by dividing the paper space units by the
model space units.

Annotation scale — This is used to determine text height or the overall scale of an annotation object. The
approach used to calculate an annotation scale depends on whether the object is placed in model space
or on a layout.

Display lock (Viewport Locking) — Locks the scale that you set for the selected viewport. Once the scale
is locked, you can continue to modify the geometry in the viewport without affecting the viewport scale
or model position within the viewport. Note that if you lock a viewport scale most of the view commands
such as VPOINT, DVIEW, 3DORBIT, PLAN, and VIEW, no longer work in that viewport.
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Designing a Layout
The following is typical of the process used to design a layout environment.

1. Create a model drawing

2. Create a layout

3. Specify layout page settings such as plotting device, paper size, plot area, plot scale and
drawing orientation

4. Insert a title block
5. Create floating viewport(s) and position them in the layout
6. Set the scale of the viewport
7. Annotate or create geometry in the layout as needed
8. Plot the layout.
Page Setup

As mentioned previously, Layout settings, or Page setups, control the final plotted output. They
affect paper size, plot device, scale, area, origin, and drawing orientation. Understanding how
page setups are used ensures that the layout will plot as you expect.

The Page Setup dialog box is similar to the Plot dialog box. When the Page Setup dialog box is
used to change plot settings, changes are saved without actually plotting.

To invoke the PAGESETUP command do one of the following: e
e Click Application menu » Print » Page Setup. S
e Ribbon > Outputtab » Page Setup Manager Seect Al Layouts
e Command Line » PAGESETUP e
e Shortcut Menu » Right-Mouse click over the Model or Layout tab, — =

select Page Setup Manager... e

Drafting Standard Setup...

Import Layout as Sheet...

Export Layout to Model...

The Page Setup dialog will be displayed. Dock sbove ratus Bar

In addition to displaying the current Plot device name, the Plotter, Plot size, Location and description,
the Page Setup Manager displays all of the layouts in the current drawing as well as Page setups.

Within the dialog one can create a new page setup, modify an existing page setup or import an existing
page setup from a drawing, template or DXF file on a local or network drive.

e Selecting the New option will display a dialog in which the name of the page setup is
added. Once OK is selected the Page Setup dialog appears.

e Selecting Modify will launch the Page Setup dialog

e Selecting Import will bring launch Windows Explorer, once a file with page setups is
selected all page setups in that drawing are listed allowing one to select and import one
or all page setups.
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Example of Page Setup Manager in a working drawing file

Current Layout name
Current Page setup name Aot 0 =
Layout name and the page :w““ o o

setup applied to that layout. e

The page setup is shown
between parenthesis

Layouts existing in the drawing. o e

[ modfy... |

[ mmpart... |

Device name:

Platter:

Note the Asterisk (*) enclosing e

the name | ——

Page setups saved within the rsbacgioes (] (e ]
drawing.

Note that when you activate a layout for the first time the default layout is set as an 8.5 x 11 sheet of
paper. When you modify the sheet size in the Page Setup Manager that size will be reflected on the
screen once the settings have been applied. Any viewports already existing in a layout will not resize.

Adding a new page setup to a new layout

1.
2.

6.
7.

Open Floor Plan plot.dwg

Right-Mouse click over any Layout tab and select New Layout from the shortcut menu.
Note that AutoCAD 2015 has an additional tab next to the layout tabs labeled with a
plus (+) sign. This allows for quickly adding a layout from scratch.

Select the newly created Layout to make it active. By default a viewport is created
showing the extents of the model drawing on an 8.5x11 sheet of paper.

Right-Mouse click the Layout tab and select Rename. Rename the Layout AU 2014 E Size
Monochrome.

Right-Mouse click the Layout AU 2014 E Size Monochrome and select Page Setup
Manager. The Page Setup Manager dialog appears.

Select New...

In the New Page Setup add the name ANSI E 34x44 Monochrome and click OK.

The Page Setup dialog appears. Note that this is identical to the Plot dialog which we discussed earlier in
this document. The exception being that under Plot area » What to plot: The option to plot by
Layout is available and the option to plot to Limits has been removed. Aside from the new Page
Setup name, the settings you see either defaults from a previous plot or defaults which have
been assigned in the Options > Plot and Publish tab. More details on these defaults later.

8.
9.

In the Page Setup dialog, change or verify the following values:
Pinter/Plotter: DWG to PDF.PC3
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10.
11.
12.
13.
14.
15.

16.
17.
18.

19.

20.
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Paper size: ANSI E (34.00 x 44.00 Inches)

Plot Area: Layout

Plot Scale: 1:1

Plot Style table: monochrome.ctb

Select Preview...

Note that the paper size has changed but the viewport is now a small rectangle in the
lower left corner

Right-Mouse click and select Exit or use the ESC key to cancel the preview

In the Page Setup dialog click OK to close

Note the AU 2014 E Size Monochrome page setup name now listed in the Page Setup
Manager

Double-Click the name (or select the name and then click Set Current), this applies the
page setup to the current layout. If you then make changes to the page setup, they will
be reflected in all layouts which have that page setup assigned.

Close the Page Setup Manager and save the drawing.

More about Layouts
Taking another glance at the layout in our drawing, one will notice that it does appear to represent a
sheet of paper. The following examines the visuals of the Layout.

A.

Although difficult to tell in
AutoCAD 2015, there is a shadow
border here. This is to give it a 3D
feel.

This is what would be the physical
edge of the sheet of paper.

The dashed line represents the
printable area of the sheet of
paper. This is dictated by the plot
device driver associated with the
page setup

This is a viewport added to the
layout.
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Layout elements

[¥] Display Layout and Maodel tabs
The settings for these visuals (A-C) can be (V'] Display printable area
enabled or disabled in the Options » Display || Display paper background
tab » Layout elements [¥] Display paper shadow

[] Show Page Setup Manager for new layouts
[¥] Create viewpart in new layouts

As mentioned previously, layouts can be -

New Layout

copied, moved or deleted. Much of this From Template..
functionality is available by Right-Mouse e
clicking over a layout tab. An alternative is to k ———
Press, then drag the layout to a new location Activate Previous Layout
or hold down the CTRL key while dragging and Eﬁ% o ?::ﬁt;”;
dropping to copy the layout. NOTE: In order to 5;."""."5 Seanint i

Drag, Drop and Copy (with CTRL Key) in 2015 hutomtic sme o Csercocconpptel [
versions you must have Service Pack two Dock sbive ot e

installed.

Layouts can also be easily exported for reuse and imported using the “From Template” option of the
shortcut menu or through the use of Design Center.

About Viewports

Think of Viewports as a window allowing you to view the model. You can create a single layout viewport
that fits the entire layout or create multiple layout viewports in the layout. Each layout viewport
contains a view that displays the model at the scale and orientation that you specify. Once you create
the viewports, you can change their size, their properties, and also scale and move them as needed. You
can also use COPY create multiple layout viewports.

It's recommended that you create viewports on a specific layer, VPORTS or Viewports are commonly
used as layer names. Once you’ve done this you can easily turn off or freeze the layers so that the
viewports are not visible. Although turning off or freezing the layers is common, in my opinion it is
better to disable plotting of the specific layer in the Layer Manager, this allows you to see the viewport
yet not have the frame appear on the hardcopy or electronic output. The choice is yours or determined
by your organizations CAD standards, often time’s users prefer to have the frame plot.
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.
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The Viewport dialog No-Plot layer

Once a viewport is created, the appropriate scale factor is assigned to that viewport. For example, the
viewport would have a scale factor of 1/8”=1'0" (or 96) assigned to display the model. Then the layout
would be plotted at a scale of 1:1. This truly simplifies working with multiple views in a drawing.

Note that when you use commands such as the Zoom command while in an active viewport, the scale
factor is lost. To avoid this issue, once a scale factor is assigned, lock the viewport. This can be done
using the Properties Manager or by selecting the viewport and Right-Mouse clicking. From the shortcut
menu choose Display locked » Yes.

Hint: One can also save a view of the model in the viewport, easily restoring it in a current or new
viewport. This is done using the VIEW command.

Having multiple viewports and displaying them with different scale factors is only one of the benefits of
using viewports. Individual viewports can have property override applied using the layer manager. For
example, if you prefer to have new construction layers stand out with a different lineweight, color or
other property, viewport overrides can be used. Additionally, you can freeze specific layers per
viewport.
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1. New VP Freeze — Freezes the layer
in any new viewports in the current
layout

2. VP Freeze — Freeze the layer in the
current viewport only

3. VP Color — Override color property
in current viewport

4. VP Linetype — Override linetype
property in current viewport

5. VP Lineweight — Override
lineweight property in current
viewport

6. VP Transparency — Override
transparency in current viewport

7. VP Plot Style — Override plot style
in current viewport

Layers with overrides applied appear by
default with a light blue highlight. One can
easily remove overrides by Right-Mouse
clicking a specific layer and selecting Remove
Viewport Overrides for, then select the
appropriate option from the submenu.

To create viewports

Remove From Group Fitter

Remaove Viewport Overrides for

New Layer VP Frozen in All Viewports
VP Freeze Layer

VP Thaw Layer in All Viewports
Isolate selected layers

Merge selected layer(s) to

Select All

Clear All

Select All but Current

Invert Selection

Invert Layer Filker
Leyer Filters

Save Layer States...
Restore Layer State..

Plan to Plot: From Page Setup to Output

, Transparency
Selected Layers

e Ribbon » Layouttab » Layout Viewports » Rectangular or Non-Rectangular (Note:

The Layouts tab is only available once you have switched to a Layout tab)
e Command Line » VPORTS (opens dialog)
e Command Line » MVIEW or —-VPORTS
¢ Command Line » MVSETUP (not available in AutoCAD LT)

To make a viewport active, double-click within the viewport. When the viewport is active the
mouse pointer will appear as the default AutoCAD cross-hair. To make paper space active,
double-click in an area outside of the viewport. The paper space icon will reappear. An
alternative is to click the Paper/Model icon on the AutoCAD status bar. This will switch between
spaces. The TILEMODE (System Variable) also switches between spaces.
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Exercise: Working with Viewports and Layouts

vk wnN e

Continue with, or Open "Floor Plan Plot.dwg"
Verify the paper space environment is active (double-click outside of the viewport)

Erase the lone viewport

Set the layer “Title Block” current

Use the INSERT command to insert the block, “Generic ANSI E 34x44 Block”
a. Insertion Point: 0,0
b. Scale: 1 (select uniform scale)
¢. Rotation: 0

Use the Layer command to open the Layer Property

Create a new layer called, “VPORTS”

a. Color: 254
b. Set plot to no-plot (select the printer icon in the Plot column)

c. Set the layer current

Close or auto-hide the Layer Palette
From the Ribbon » Layout tab » Rectangular, create a viewport using the entire area

within the title block. You may want to temporarily disable OSNAPs (F3) so that you
don’t draw the viewport over the title block.

Scale to fit
11
1/128" = 1"-0"
1/64" =1-0"
1/32° =1-0"
/16" =1-0°
- 10m
-1
" _1.00
- o1
-1
-1
- o1

= factor (nX or nXP), or
cale/Window/Object] <real time>: e

10. When a viewport is added, AutoCAD will display the model’s extents in the viewport,
thereby applying an arbitrary scale factor.
a. Selected viewport
b. Arbitrary scale factor
c. Desired scale factor
11. Select the Viewport
12. Select the Scale List (B)
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13. Select 1/8”=1"0" for the desired scale factor.

14.
15.
16.
17.
18.
19.
20.
21.
22.
23.

Select the viewport and Right-Mouse click

Select Display locked » Yes

Double-click within the viewport

Open the Layer Properties Manager

In the VP Freeze column, freeze the layer GRIDLN

Close or auto-hide the layer palette

Double-click outside of the viewport to activate paper space

Type PREVIEW to see a plot preview of the layout

Right-Mouse click and select exit or ESC from the keyboard to return to the layout view
Save the drawing

The plot preview was displayed in monochrome, yet the drawing is in color. This occurred because in the
previous page setup exercise a monochrome plot style (CTB)* was applied to the layout and it is
indicated in the layout name, AU 2014 E Size Monochrome, that this layout has been setup for
monochrome plotting.

*Plot styles will be discussed shortly

Next we’ll make a copy of the layout and modify it for detail views and color plotting.

Exercise: Working with Viewports and Layouts — part two

1.
2.

3.

Continue with, or Open "Floor Plan Plot.dwg"

Right-Mouse click over the AU 2014 E Size Monochrome layout tab and select “Move or
Copy”

In the Move or Copy dialog select, (move to end) and check the box Create a copy

Note that you can also Left-Mouse pick while holding down the CTRL key and dragging a copy
to a specified location. With AutoCAD 2015 versions you will need Service Pack 2 installed in
order for this function to work.

4,

5.
6.
7.

Rename the layout AU 2014 E Size Monochrome(2) to AU 2014 E Size Color by selecting
and Right-Mouse clicking, from the shortcut menu select Rename. You may also double-
click the name to enter the edit mode.

Activate the new layout by selecting the layout tab

Since this is an exact duplicate, erase the viewport in the layout

Right-Mouse click over the layout tab and select Page Setup Manager

Note that the page setup ANSI E 34x44 Monochrome is applied to this layout. Next we'll create a new
page setup based on this one.

8.

In the Page Setup Manager select New...
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10.
11.
12.
13.
14.
15.
16.
17.
18.

19.
20.
21.
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Name the page setup, ANSI E 34x44 Color

Select OK to enter the Page Setup dialog

Under Plot style table (pen assignments), select acad.ctb

Select OK to exit the Page Setup dialog

Se ANSI E 34x44 Color current

Select Close to exit the Page Setup Manager

Save the drawing (A good habit)

Verify that the VPORTS layer is current

Type MVIEW or MV at the command prompt

Pick a point in the top left corner of the layout (within the title block) and draw a
rectangular viewport encompassing about a quarter of the layout.

Select the viewport and apply a scale factor of 1/4"=1"-0"

Double-click within the viewport to activate it

Open the Layer Properties Palette (Type LAYER or LA), Locate layer GRIDLN and then
select the icon in the VP Freeze and the New VP Freeze columns.

The layer GRIDLN will not appear in the current viewport, nor any new viewports within this layout.

22.
23.

24,
25.

26.
27.

Activate paper space by double-clicking outside of the viewport

Using the PLINE command draw a closed polyline around the nook of the building as
shown below.

From the Ribbon » Layout tab » Layout Viewports, select Clip

Following the command prompts, first select the viewport, then select the closed
polyline.

ENTER to finish the command. The viewport now has a new boundary.

Select the viewport and Right-Mouse click to lock the viewport scale

Rectangular Viewport Closed Polyline Clipped Viewport
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Home  Insert  Annotatd

Converting Objects to Viewports !é ‘- E
28. Draw a circle to the right of the viewport approximately the New f:tﬂ‘; T R

same size as the viewport Layout ‘ e
29. From the Ribbon » Layout tab » Layout Viewports, select Floor Plan F

Object q Felyguna)
30. Select the circle and ENTER Object
31. The Circle is converted to a viewport

32.

33.
34.
35.

Activate the viewport and zoom into the room located in the lower right-hand corner of
the drawing.

Once the view is centered, double-click outside the viewport to make paper space active
Assign a scale factor of 1/2”=1’-0"

Lock the Viewport

Using Viewport Overrides

36.
37.
38.
39.
40.
41.

42.
43.
44,
45.
46.

Create a Rectangular Viewport at the bottom of the layout
Scale the viewport to 1/16”=1"-0"

Lock the viewport

Make the viewport active

Open the Layer Properties Manager

Select the following layers:

a. CPU

b. Chair

c. File_Cabinets
d. Furniture

e. Phones

f.  Printer_Island
In the VP Color column, select one of the color swatches and assign a value of 254
Close the Layer Property Palette
Zoom to Extents
Save the Drawing
Plot
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Finished Layout
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About Plot Style Tables
Plot style tables contain several of the plot settings you use when plotting a drawing. You can

use a table to reduce the number of redundant steps you need to perform each time you plot a
drawing.

There are two types of plot style tables: color-dependent (CTB files) and named (STB files).

A plot style is similar to a text or dimension style, which determine how text and dimensions
look. Plot styles determine how objects appear when plotted.

A plot style table is attached to a layout or to model space in order to apply the plot style
parameters to objects in the drawing at plot time.

AutoCAD drawings are either color-dependent or named, they cannot be both.

One can use templates provided with AutoCAD or AutoCAD LT or custom templates to begin a
new drawing using a desired plot style type.

If no templates are present or if an AutoCAD R14 or earlier drawing is opened, the
PSTYLEPOLICY system variable determines the plot style used.

The Plot Style Manager

The Plot Style Manager displays the Windows location (determined in OPTIONS) of plot styles installed
with AutoCAD (LT), as well as the Add-A-Plot Style wizard which is used to create new plot styles. One
can modify existing plot styles by double-clicking the plot style or from within the Page Setup Manager
using the plot style table Edit tool.

Color-dependent plot style tables
Designed to be similar to pen assignments used in AutoCAD release 14 and earlier they are
device independent. The same table can be used for more than one plot device

External files that are stored with the file extension .CTB (Color Table)

A color-dependent plot style table contains 255 preset plot styles — one for each color in the
AutoCAD Color Index. Additionally one can choose from true colors, as well as color books.

When a drawing is plotted, AutoCAD reads the Color property of each object. Using a Plot Style
table you can specify the color, lineweight, linetype, screening and so on, that objects of a
specific color will have when plotted.

Named Plot Style tables
Named plot styles allow for more control over plotting because they are applied independent of
object color on an object-by-object or layer-by-layer basis.
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Where color-dependent plot styles associate plot parameters based on the color of objects so
that all objects of the color plot with the same parameters, named plot styles are assigned to
individual objects or to layers, allowing objects of the same color to be plotted differently.

Plot Style Properties

e Color - Determines the plot color of objects that use the selected AutoCAD color. Object
color uses the color assigned to the object or layer. Color overrides occur when a
different color is chosen.

o Dither - Approximates a color by making dot patterns with one of the device-supported
colors. Use dithering if the plot device does not support the color you want to plot.

For example, if you send a color plot to a monochrome device but still want to
distinguish between the different colors, turn on dithering so that the plot device
creates a dot patterns to distinguish between colors.

I recommend turning this off for monochrome because in most cases the drawing looks
pixelated. Note also that dithering automatically turns on if you set a color screening value of
99 or less.

e Grayscale - Plots objects using the selected AutoCAD color as a shade of gray. Yellow
would plot as light gray, whereas Blue would plot as a darker shade.

e Pen Number - For pen plotters only. Determines pen number used to plot objects of the
selected AutoCAD color. (Basically Obsolete)

Note: When plotting to a pen plotter, all other plot style table properties are ignored.

e Virtual Pen - Reflect back to when you had to use a different physical ink pen for each
line weight. Virtual pens are assigned by the hardware.

Note: When plotting to a virtual pens, all other plot style table properties are ignored.

¢ Screening - Determines the color intensity of objects that use the selected AutoCAD
color when plotted. Entering (0) reduces the color to white.
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OOv‘ <« Roaming b Autodesk » AutoCAD 2015 » R200 » enu b Plotters b Plot Styles

Linetype - Determines the plotted linetype of objects that used the Selected AutoCAD
color. Selecting a linetype will override the linetype assigned to that color.

Adaptive - Adjusts the size of the linetype pattern so that line objects contain complete
patterns. This only affects linetype set in a plot style table.
Lineweight - Determines the plotted lineweight. Selected lineweight overrides assigned
lineweight
Line End Style - Determines the line end style of object that use the selected AutoCAD

File Edit View Tools Help

Organize ~ | [Z Open ~

457 Favorites

Name

Share with Mew folder

Date modified

Type

Add Style

& Autodesk 360 acad.cth 3/9/1999 1317 AutoCAD Color-d... 5KB
= Box Syne acad sth 3/9/199913:16 AutoCAD Plot Styl... 1KB
¥ Copy 84| Add-A-Plot Style Table Wizard 11/25/20140815  Shortcut 2KB
B Desktop [l Autodesk-Color stb 11/21/20021817  AutoCAD Plot Styl... 1KB
Downloads Autodesk-MONO.sth 11/21/20021822  AutoCAD Plot Styl... 1KB
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Partial view of the Plot Style Manager (Windows Explorer), the Add-A-Plot
Style Table Wizard, and sample plot styles for both Color-dependent and
Named-plot styles.
Color-dependent Plot Style Table
Named-Plot Style Table

Exercise: Creating a Color-dependent Plot Style

1. Open Floor Plan - Color Based.dwg.
2. Atthe command prompt type, Preview.
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a. Briefly review the visual display of the geometry.
b. Exit the Plot Preview
3. Select the Application Menu » Print » Manage Plot Styles or type STYLESMANAGER
at the command prompt.
Double-click Add-A-Plot Style Table Wizard.
On the first information page, select Next.
On the page titled Begin, leave Start from Scratch selected and select Next.
On the page titled Pick Plot Style Table, leave Color-dependent Plot Style Table selected
and select Next.
. On the File Name page, enter Check Plot - BW in the file name box. Select Next.
9. Select Plot Style Table Editor.
10. In the Plot Style Table Editor, Form View tab, select the first nine colors in the Plot Styles
list, but do not select color 4. Under Properties:
a. Set the Color to Black.
b. Turn Dither to Off.
c. Select 0.0000 mm for the Lineweight.
11. Select Save & Close.
12. Select Finish.
13. Right-click on the First Floor layout tab. Select Page Setup Manager.
14. In the Page Setup Manager:
Select Modify.
b. Select Check Plot - BW.ctb in the Plot Style Table list.
c. Select OK.
d. Select Close.
15. Type Preview at the command prompt
16. In reviewing the preview while using this CTB file, you should see that all the geometry
that falls in the color range of 1-3 and 5-9 now previews in black.
a. Zoom into the front porch area to see the difference in the line width for the
geometry that was cyan, Color 4.
b. Exit the Plot Preview.

No vk

Q

Exercise: Creating a Named-Plot Style

1. Open Floor Plan - Named Based.dwg.
2. At the command prompt type, Preview
a. Briefly review the visual display of the geometry.
b. Exit the Plot Preview
3. Select the Application Menu » Print » Manage Plot Styles or type STYLESMANAGER
at the command prompt
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13.
14.
15.
16.
17.

18.
19.
20.
21.
22.
23.
24,
25.
26.

27.

28.
29.
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Double-click the file acad.stb

Select the Form View tab

Select Save As..., name the new table, AU2014.5TB
On the Form View Tab:

Select Add Style.

Enter THICK in the Add Plot Style dialog box.

. Select OK.
. With the THICK plot style highlighted, change the following properties:

a. Color: Black
b. Dither: Off
c. Lineweight: 0.7000 mm
Next, you create a new style by copying the style THICK.
Right-click the plot style THICK. Select Copy.
Right-click in the Plot Styles list area. Select Paste.
Enter MEDIUM in the Add Plot Style dialog box. Select OK.
With the MEDIUM plot style highlighted, change the Lineweight property to 0.5000 mm.
Create another new style using the same copy and paste procedures you used to create
the style MEDIUM.
Enter THIN for the style name.
Select OK.
With the THIN plot style selected, change the Lineweight property to 0.350 mm.
Create another new style called SCREEN-40 using copy and paste. Select OK.
With the SCREEN-40 plot style selected, change the Screening property to 40.
Select Save.
In the Plot Style Table Editor, select Save & Close.
Type LAYER, to launch the Layer Properties Manager.
In the Layer Properties Manager, select the Plot Style value for the layer TitleBlock in the
Plot Style column.
In the Select Plot Style dialog box:
a. Select AU2014.STB for the Active Plot Style Table.
b. Select THICK in the list of Plot Styles.
Select OK.
In the Plot Style column in the Layer Properties Manager, continue making changes for
the identified layers by assigning the specified named style. Select OK after making the
changes. They should appear as shown:
a. CHAIRS = SCREEN-40
b. DB -Windows = MEDIUM
c. Deck=THIN
d. Furniture = SCREEN-40
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e. View Labels = MEDIUM

f. Walls = MEDIUM
30. Close the Layer Properties Manager
31. At the command prompt type, Preview

In reviewing the preview image, you will notice that geometry assigned to the identified layers preview
in different colors and with different line widths. If you look closely, you can see that the desk and chairs
appear in a shade of black because the screening property is only allowing 40% of the color through.
Also note that the text in the title block is still displaying in color, while the line geometry is black.

32. Exit the Plot Preview.
33. Save and close all files.

Conclusion
There is much more to plotting and the tools associated with the task. This document should get you
started, but | encourage you to take advantage of the resources available in the AutoCAD Help system as

well as the Autodesk Knowledge Network and the Autodesk Help Webinars. Explore and Learn!
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Additional Resources

o About Controlling PC3 File Device and Document Settings

e About Adjusting the Grid and Grid Snap

e About Annotation Scale

e About Layout Viewports

Commands and System Variables associated with Plotting.
Commands

e CONVERTCTB (Command)

o CONVERTPSTYLES (Command)

e PAGESETUP (Command)

e PCINWIZARD (Command)

¢ PLOT (Command)

e PLOTSTAMP (Command)

e PLOTSTYLE (Command)

e PLOTTERMANAGER (Command)

e PREVIEW (Command)

e PSETUPIN (Command)

e STYLESMANAGER (Command)

e VIEWPLOTDETAILS (Command)

e LIMITS (Command)

e VIEW (Command)
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System Variables

CPLOTSTYLE (System Variable)

PAPERUPDATE (System Variable)

PLOTOFFSET (System Variable)

PLOTROTMODE (System Variable)

PLOTTRANSPARENCYOVERRIDE (System Variable)

PLQUIET (System Variable)

PSTYLEMODE (System Variable)

PSTYLEPOLICY (System Variable)

RASTERDPI (System Variable)

RASTERPERCENT (System Variable)

RASTERTHRESHOLD (System Variable)

MAXACTVP (System Variable)

TEXTFILL (System Variable)

TEXTOLTY (System Variable)

TILEMODE (System Variable)
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Drawing Scale Scale Factor Plotted Text Height

1/16" 3/32" | 1/8" | 3/16" | 1/4" | 5/16" | 3/8" | 1/2" | 5/8"
1/16"=1"-0" 192 12" 18" 24" 36" 48" 60" 66" 96" 120"
1/8"=1'-0" 96 6" 9" 12" 18" 24" 30" 36" 48" 60"
3/16"=1'-0" 64 4" 6" 8" 12" 16" 20" 24" 32" 40"
1/4"=1'-0" 48 3" 4.5" 6" 9' 12" 15" 18" 24" 30"
3/8"=1"-0" 32 2" 3" 4" 6" 8" 10" 12" 16" 20"
1/2"=1'-0" 24 1.5" 2.25" 3" 4.5" 6" 7.5" 9" 12" 15"
3/4=1'-0" 16 1" 1.5" 2" 3" 4" 5" 6" 8" 10"
1"=1'-0" 12 0.75" 1.13" 1.5" 2.25" 3" 4" 5" 6" 7.5"
11/2=1'-0 8 0.5" 75" 1" 1.5" 2" 2.5" 3" 4" 5"
3"=1'-0" 4 0.25" .375" 0.5" 0.75" 1" 1.25" 1.5" 2" 2.5"
1" =10' 120 7.5" 11.25" 15" 22.5" 30" 37.5" 45" 60" 75"
1" =20' 240 15" 22.5" 30" 45" 60" 75" 90" 120" 150"
1" =30' 360 22.5" 33.75" 45" 67.5" 90" 112.5" 135" 180" 225"
1" =40' 480 30" 45" 60" 90" 120" 150" 180" 240" 300"
1" =50' 600 37.5" 56.25" 75" 112.5" 150" 187.5" 225" 300" 375"
1" =60' 720 45" 67.5" 90" 135" 180" 225" 270" 360" 450"
1"=70' 840 52.5" 78.75" 105" 157.5" 210" 262.5" 315" 420" 525"
1" =80' 960 60" 90" 120" 180" 240" 300" 360" 480" 600"
1" =90' 1080 67.5" 101.25" 135" 202.5" 270" 337.5" 405" 540" 675"
1" =100’ 1200 75" 101.25" 150" 225" 300" 375" 450" 600" 750"
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